BASIC Powerpoint drawing functions.

A) 
Start Powerpoint and create a blank “slide” on which to put our drawing.

1. If it comes up with a “Wizard dialog”, choose “Blank Presentation”, otherwise, choose “New” and choose “Blank Presentation” from the “General” Tab.

2. You will be presented with several slide templates. Choose the one on the lower right (blank). Press OK. The area to the right of our screen is the “slide” where we do our work. To the left is a list of slides that allows us to choose between several different displays (the British OBs have a lot of them). We chose the blank slide, so it has no title. It is also possible to create them with titles, as we will see later. Almost all of the simple drawing will use either blank or simple title slides.

B)
Lets build and play with an infantry symbol.

1. Look to the bottom left of the screen. You will see “AutoShapes”. To the right are several symbols, one of which is a rectangle. Left click on the rectangle and then left click anywhere on the blank slide, dragging the mouse by holding down on the left-button if necessary. A box should appear on the slide and it may have a background color.  You can change its shape by clicking on the small boxes that appear on the perimeter of the shape. If no boxes appear, left-click in the middle of the rectangle and they should reappear (this is “selecting” the shape). Click anywhere outside the box and the boxes should disappear (“deselecting”). 

2. Select the box and move your cursor into the middle. It should look like a + with arrows on the 4 sides. This indicates that the shape is ready to move. Hold down the left mouse button and drag the box somewhere on the slide.

3. Now for one of the most important functions of all. Click on the Edit dropdown (upper left) and click “Undo Move Object”. The box should revert back to its original position.  PPT stores the last few actions so you can usually undo a mistake. In this case the last action was “Move Object”, so you can undo your movement. You can undo almost anything you do, either deliberately or (more often) by mistake.  You will find yourself using this OFTEN! It can be invoked by the ctrl-Z shortcut keys as well as the dropdown.

4. Lets make the box 1.5 times as wide as it is long:

a. Select the box

b. Right click inside the box

c. Choose “Format Autoshape” (near the bottom of the list).

d. Choose the size tab and set the height = 1and  the width = 1.5

e. Click OK. The box will now be 1.5 inches x 1 inch


5.    Lets make the cross in the middle of the infantry symbol:

a. From autoshapes, choose the diagonal line symbol (immediately to the right of the word “Autoshapes” and click anywhere on the slide and then hold the left mouse button down and drag the cursor to another position to the upper right on the slide. A line should appear between the two points.

b. Right click it and use format autoshape to change its size to 1.5 Width, 1 height.

c. Repeat this process for a line going from upper left to lower right.

d. You should now have two lines and a box on the screen. Select all three of them by holding the shift key down and clicking on them until small boxes appear around all of them.

e. Look to the lower left of the screen and click on the Draw dropdown.  Select “Align and Distribute” and then successively choose “Align Middle” and “Align Center”. The two lines and the box should be centered and it should look like an infantry symbol. Note: If the lines should disappear, see the next step.

f. The objects on the screen have a “z-order” in that certain objects are displayed “in-front” of others. In this case, we want the two lines in front of the box. Select the box and right click. Choose “Order” and then “bring to front” and see what happens (the lines should disappear, but they are actually still there, just “behind the box”. Now choose “Order” and “Send to back” and the lines should reappear.

g. Lets move our infantry symbol somewhere else - select the box and move it - What happened??? The lines are not associated with the box yet, so the box moved by itself, leaving the lines behind. Before we go further, we must “group” the three objects into a single symbol.

h. First, use the “undo” action to put the box back in its original position. Then select all three objects by either clicking on each individually with the shift key held down OR left clicking to the upper left of the symbol and then dragging the cursor down below and right of the symbol while holding down the left mouse button (you will see a rectangle appear as you do this) and then releasing when you have enclosed the entire symbol. Either action should result in all 3 items being selected.

i. Either right click in the box and choose “grouping->group” OR use the Draw dropdown (lower left) and choose “Group” from the top. This turns our two lines and box into an infantry symbol that can be manipulated as a unit. You can ungroup them too by selecting the symbol and choosing “Ungroup”. Leave them grouped.

j. Make the infantry symbol 1/2 as big by using format object (now that you are dealing with the grouped symbols it is no longer called format autoshape) and the size tab. First set the height = 50%  and click OK. This makes it flatter, but is probably not what we want. Use edit/undo to set it back to its original size.

k. Repeat the above step but before you make the change, set the “lock aspect ratio” box on. Now when you set the height = 50%, the width decreases also.

l. Lets make a copy of the infantry symbol. Select it and choose ctrl-C or edit->copy. Then choose ctrl-V or edit-paste. These work just like word processing (ctrl-X/ctrl-V can also be used to cut instead of ctrl-C/ctrl-X copy and paste ). However, the copy is not made where the cursor points but is usually to the lower right of the original (this can occasionally be frustrating). If you go to a different slide, the copy will be on the new slide in the same position it was on the original slide.

m. Make 3 or 4 infantry symbols and randomly distribute them over the slide. Then align them vertically (draw->Align->Center). Now put them in a uniform vertical distribution by selecting all of them and using (draw->Align->Distribute Vertically) (you may need to expand the dropdown to see the (Distribute Vertically option). Scatter them again and do a similar task to align them horizontally (draw->Align->Middle) and distribute them along a horizontal line (draw->Align->Distribute Horizontally).

n. Lets make a British Infantry Symbol by changing the background color (or colour for non-colonial types). Select an infantry symbol and choose the downarrow next to the little paintcan symbol on the bottom of the screen (fill color). Choose the more-fill-colors option and choose one which approximates light brown. Click OK. Voila. Note that this option is also available on the Format Object screen that comes up when you right click on an object.

o. Change the line color by choosing the downarrow next to the little paintbrush symbol. 

p. You can also choose the color of your text by using the downarrow next to the A.

q. You can change the thickness and pattern of lines by using the two dropdowns next to the line color (A) button. For the OBs, I generally use 1 1/2 point solid lines or dashed lines for attachments.

r. You can stretch or compress an object by clicking on one of the boxes around the perimeter and dragging the mouse. Beware of this if you have several objects or a grouped object selected, as they all will be stretched and this might not be what you want (UNDO is useful here).

s. You can focus in on a particular area of the screen by using the View->Zoom or Zoom option. The view will center on any object you have selected. This is especially useful for constructing small symbols such as the paratroop symbol (for which I used two semicircles from the Autoshapes dropdown and stretched them), or the Marine symbol.

t. For our purpose, text boxes are easiest to manipulate if they have no border. create a text box and format it. On the text box tab, set all of the internal margins to 0. Then go to the first tab (colors and lines) and set the “default for new objects”. New text boxes should  then have these properties.

This should be enough to get you started - Practice a bit, use the other alignment options (DRAW->Align or Distribute) and then look at the Autoshapes dropdown. This allows you to do triangles, polygons and shapes. The basic-shapes “Free-form” option would be especially good for maps, as it allows you to define an enclosed space that can then be used with fill colors. Fill colors will translate nicely into small maps. You can save your work using the usual File/save options.

C)
Map Making

Powerpoint is a very powerful tool for making maps. By using the various drawing tools, you can create muli-color maps that translate very well into web graphics (use solid colors).  There are some neat tricks that you need to know to reduce frustration:

1. Become very familiar with the z-order. This allows you to put objects in front of other objects.

2. Learn how to draw straight lines. By holding the shift key down when you are creating a line, the computer will attempt to make it as straight as possible. This is easy when drawing a horizontal or vertical line, but you can also get diagonal lines (it seems to allow you to create a straight diagonal line every 15 degrees or so you have 5 intermediate settings between horizontal and vertical). Experiment with this by creating a line with the shift key depressed.

3. Create and copy common objects. For example, if we want to create a wooded area, it would be nice to have some trees in it. Use the zoom feature (either view->zoom or the zoom percentage tool on the toolbar) to go to a high zoom and draw a small tree using a brown trunk and small green lines (evergreen) or circles (deciduous). Group it together and then shrink it using the autoformat tool. You can then make copies of your tree on a green background for the woods. Most importantly, you can save common objects like trees, houses, bridges, rocky areas, etc. and copy them into new maps so you don't need to draw them again.

4. Advanced line drawing: crooked lines, curves, and free-form. Next to the standard line drawing tool is a drop-down called "auto-shapes". The first set of these is entitled "Lines" and it contains the most useful tools for map making. When you create a line using these tools, powerpoint creates it as a series of invisible points. If you select the line and right-click it, you will see the "edit-points" option. Clicking on these will allow you to individually adjust them, so you can get just the right effect.

Given the above, lets build a simple map.

1. Start a new slide and put a rectangle on it. Make the rectangle 4" by 5" (autoshape size) and give it an appropriate light green background color. This is our basic table surface.

2. Create a road by selecting the line tool and drawing a straight line horizontally across the surface. Adjust the endpoints to correspond with the edges of the map. Make it grey (line color) and 2 1/4 points thick (line style) for a paved road.

3. Create a stream-Use the autoshape curve tool and draw from the top to the bottom of the rectangle. Every 1/2 inch or so, move the mouse pointer slightly off-line and left-click. You will see the curve adjust to include this point. When you are done, hit the escape key to stop the curve. Then select this curve, color it blue and make it 4 points thick using the line color/style tools you used for the road.

4. At this point we have 3 objects, but they might not be in the proper order. The road should be on top of the stream, which in turn should be on top of the background. If this is not the case, we will need to adjust the z-order by using the Draw-order tool (click on the draw dropdown at the lower left). Select the basic table surface to the rear using "send to back". Then select the road and "Bring to front". This leaves the stream. Select it and "send backwards". If it disappears behind the table surface, keep it selected and "bring forward".  Play with these until you feel comfortable with them.

5. Now every road needs a bridge, so lets build one. At the intersection of the road and stream, draw a small horizontal line across the stream. Make it 1.5 points thick and black. Adjust its position using the up and down arrows (note that it should move smoothly. If the position seems to jump around, you may have "snap to grid" selected. Deselecting it on the SNAP option of the draw dropdown can turn this off). Put it next to the road and then go to zoom 400%. Right click on the bridge line and select "edit-points". Add two points in the line and then use the cursor to drag them so that you have a crooked line which is 1/2 of the standard bridge shape. You could repeat this process for the other half of the bridge, but instead, copy the shape and select the copy. Right-click and "Format Autoshape". Select Size and then look for "rotation" as one of the options. Rotate the shape 180 degrees. Now align the two parts of the bridge and adjust them to the proper bridge width. Finally, group them together. We will use the bridge later. Return to 100% zoom.

6. Lets build a secondary road. Starting somewhere on the mainroad, draw a line off to the upper right. Make it 2 points thick and brown. Select it, right click and then give it some twists by adding extra points and pulling them. Make sure it crosses the stream at an angle. Make a copy of the bridge and move it up to the crossing point. Using the autoformat object rotation tool so the secondary road crosses the bridge.

7. Now for some woods-Using the freeform tool, draw an irregular shape for your woods. Select it, right click it and choose "close curve". Then choose the fill color (the paint can next to line color) and choose a darker green. Finally, choose the line color and either choose no line or black. If your woods are not the right shape, choose "Edit points" and move the points around. You can do this with curves too.

8. I made a small evergreen tree (brown trunk with some diagonal green lines), and then copied it all over the woods.

9. Finally, a town. Make a small rectangle and color it light grey. Put a line through the middle for a multi-sector building. Then group it and put them near the intersection of the two roads. Make some copies and distribute them around. Rotate some of them to parallel the secondary road (right click-autoformat-rotation). Give the town a name with the Text tool. You probably want to use a small (I used bold-10 point text size. I like times-new-roman as a type face. I also like to make my text boxes without margins, as this makes them easier to manipulate. To do this, select the text box, right-click and then choose "Format text box" to select 0 margins. Then select "Set autoshape defaults" so you won't need to choose this every time.

Done-I leave further maps to the reader. See the accompanying ppt presentation I created while doing the map.

D)
Preparing your ppt for distribution.


When you are done with your order-of-battle or map, you probably want to include it in a document or put it on the web. If you send it to Fire and Fury Games, we prefer that you send us the raw PowerPoint file (so we can adjust it if we need to), but you may want to convert it yourself. Here are the steps we use. You need a photo editor. I use Paintshop Pro (about $100), but there are many others, especially the powerful (and expensive) Adobe Photoshop. From Powerpoint, use the "Save As" option to save your document as a "Tag Image File" or ".TIF" picture. TIFs are usually very large, so we want to convert them into something more useable. Edit the pictures with your photo editor and convert them to either ".PNG" (Portable Network Graphics) or ".GIF" format. PPT presentations are usually sold-color "cartoon-like" pictures that convert well to .PNG and .GIF, so you do not need to use the .jpeg compression format, which can lose some detail  Note that you can usually markedly reduce the size of the image by reducing the color-depth. Usually 256 colors will more than suffice, but play around with it until you get it right. Also, it doesn't hurt to crop unused whitespace.

